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Notes on the Connecting and Operating Instructions

This connecting and operating instructions manual contains information on the proper use of
COMPACTplus / PROFIsafe in accordance with its intended purpose.

All the information contained herein, in particular the safety notes, must be carefully observed.

Notes regarding safety and warnings are marked by this symbol .

Notes regarding important pieces of information are marked by this symbol .

This connecting and operating instructions manual must be stored carefully. It must be available for
the entire operating time of the COMPACTplus / PROFIsafe.

Leuze electronic GmbH + Co. KG is not liable for damage resulting from improper use of its
equipment. Knowledge of these instructions is an element of the knowledge required for proper use.

© Reprints and reproduction, in whole or in part, are permitted only with the explicit permission of

Leuze electronic GmbH + Co. KG
Liebigstrasse 4
82256 Fuerstenfeldbruck / Germany
Phone +49 8141 5350-0
Telefax +49 8141 5350-190
info@leuze.de
www.leuze.com
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1 General

COMPACTplus Safety Light Curtains, Multiple Light Beam Safety Devices and Muting Transceivers
are type 4 Active Opto-electronic Protective Devices (AOPDs) in accordance with EN/IEC61496-1
and (pr)EN/IEC61496-2 and SIL3 in accordance with IEC61508. COMPACTplus/PROFIsafe is the
PROFIBUS-DP version of this device with safe coupling in accordance with the PROFIsafe profile.
The term “Receiver” is used synonymous in the following with “Transceiver”, as all PROFIBUS
functions in the transceiver corresponding with those of the receiver. The transmitter is not dealt
with, as it has absolutely no PROFIBUS functionalities and can be used in any connection version
(see “Connecting and operating instructions for the function package”, chapter 7).

1.1 Certifications

Leuze electronic GmbH & Co. KG in D-82256 Fürstenfeldbruck has a certified quality assurance
system in accordance with ISO9000:2000. COMPACTplus/PROFIsafe has been developed and
produced in compliance with applicable European directives and standards. The EC prototype test
in accordance with EN IEC 61496 part 1 and part 2 and SIL3 in accordance with IEC61508 has
been granted by:

TÜV Süddeutschland Group
Zertifizierstelle
Ridlerstraße 65
D-80339 Munich

Company Product
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1.2 Symbols and terms

Symbols used:

Warning notice. This symbol indicates possible dangers.
Please pay especially close attention to these instructions!
Notes on important information.

Table 1.2-1 Symbols

Terms used:

AOPD Active Opto-electronic Protective Device.
Contactor
Monitoring (EDM)

Also called External Device Monitoring (EDM), dynamically monitors the
positive-guided normally closed contacts of downstream relays, contactors
or valves.

CPU Central Processing Unit.
CRC Cyclic Redundancy Check; running digital sum in a data telegram.
DB Data Block
Download Transfer of parameters from the master to a slave.
DR Data Record
F-parameter Parameter of a failsafe PROFIBUS device.
FB Function Block
FS Factory setting (value of a parameter with delivery from the factory, which

can be changed with switches and/or SafetyLab).
GSD Electronic device datasheet that contains the communication parameters of

a device.
Master Control unit in a bus system, distributes the bus access right to slaves.
Optical PC adapter Cable connection between the optical parametering and diagnostics

interface of the receiver and the RS232 interface of a PC.
OSSD Output Signal Switching Device (safety-relevant switching output).
PAA Process Image Outputs; memory zone in the CPU where PROFIBUS takes

the cyclic output data and writes them to the slaves without programming in
the user program

PAE Process Image Inputs; memory zone in the CPU where PROFIBUS writes
the cyclic input data fetched from the slaves without programming in the user
program

PDU Protocol Data Unit
PLC Programmable Logic Controller
PROFIsafe Application profile safe PROFIBUS device that is implemented with a safe

software component – the PROFIsafe driver.
Proxy-FB LG_PROXY function block in the S7 master PLC, which implements the

automatic parameter adjustment with the receiver.
SafetyLab Diagnostics and parameterization software for the receiver, runs on

Windows® PC.
SFC System Function
Slave The unit that is subordinate in matters communication to the master; only

sends replies on the bus to requests by the master.
Start/restart
interlock

Prevents automatic start after the supply voltage has been turned off, after
the protective field has been penetrated or activation of the external safety
circuit.

Upload Transfer of parameters from a slave to the master.

Table 1.2-2 Terms
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2 Safety notes

2.1 Dangers if the safety notes are not observed

Leuze electronic products have been developed and manufactured with stringent application of
recognized technical regulations. The protective function of these devices can, however, be
impaired if the devices are used improperly or are not used according to their specified application.
In this case danger areas cannot be or cannot be fully protected. Dangers to life and limb emerge,
which are present in the machinery or system environs.

2.2 Operating conditions and proper use

COMPACTplus/PROFIsafe are used for safeguarding danger points, danger areas as well as
safeguarding access and perimeter areas. A safety distance must be maintained between the
protective field and the danger point. This is calculated using the formulas in the specific machine-
related European C standards or in the general B1 standard EN 999. However,
COMPACTplus/PROFIsafe are not suitable as protective devices if it can be expected that objects
could be projected from the machine or hot or dangerous liquids could splash out. They are also not
suitable for machines with long stopping times. Leuze electronic provides suitable door-interlock
switches (safety switches) for such cases, both with and without guard interlocking.

Warning!

With use of the COMPACTplus/PROFIsafe it must be ensured that the response time of the device
is increased by 20 ms for the respective function compared with the information for the version with
semiconductor output in the connecting and operating instructions. Added to this is the influence of
the cycle time of the PROFIBUS and the safety PLC in accordance with the information in chapter
7.1.2, which, under certain circumstances, considerably increase the necessary safety distance to
the danger point.

The applicable requirements for machine safety apply when using COMPACTplus/PROFIsafe, in
particular:

• Machine Directive 98/37/EC and

• Machine Utilization Directive 89/655/EEC,

and the corresponding applicable national regulations in the individual member states.

It is the responsibility of the manufacturer and the operator of the machine or equipment on which
the optical safety device is installed to observe these rules and regulations. The local authorities in
charge (e.g. health and safety at work authorities) are available to answer questions concerning
safety. The following conditions for use must be observed:

The installation, electrical connection and the required test before initial operation and regular tests
must only be carried out by specialist personnel. Knowledge of the safety notes in these connecting
and operating instructions is a constituent part of this competence. Notes on the electrical
connection can be found in chapter 6.

COMPACTplus/PROFIsafe corresponds with safety category 4 in accordance with EN954-1.

To maintain this level of safety, all downstream elements of the safety chain up to stopping the
dangerous movement must be set up at least in accordance with safety category 4.
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The applicable requirements for machine safety apply when using COMPACTplus/PROFIsafe. The
responsible local authorities (e.g. health and safety at work authorities)  are available to answer
questions related to safety issues.

The following conditions for use must generally be observed:

• Work on electrical equipment must only be performed by skilled electrical personnel.

• A system test may only be performed when no danger will result for any persons.

• Initial operation, maintenance and parameter setting must only be performed by skilled
personnel. Knowledge

• of the connecting and operating instructions for the receiver’s function package,

• of the safety notes of this supplementary information for the connecting and operating
instructions,

• and the “SafetyLab” operating instructions if required,

is part of this competence.

Warning!

Adjustments and changes on the COMPACTplus/PROFIsafe can cause a loss of safety functions.

2.3 Organizational measures

2.3.1 Documentation

All details of this supplementary information for the connecting and operating instructions must be
observed. Ensure that you keep the connecting and operating instructions and this supplementary
information carefully stored in an appropriate place. They should always be available.

2.3.2 Safety regulations

Observe the locally applicable legal provisions and the regulations of the health and safety at work
authorities.

2.3.3 Qualified personnel

The installation, initial operation and maintenance of the devices must only be performed by
qualified skilled personnel. Electrical work must only be performed by skilled electrical personnel,
who also possess the necessary knowledge of the SafetyLab software, if necessary.

2.3.4 Repairs

Repairs, especially in opening the housing, must only be performed by the manufacturer or by
persons authorized by the manufacturer. Setting parameters via the DIP switches in the device and
the PROFIBUS address via the rotary switch in the connection cap are exceptions in this respect.
In both cases only the connection cap has to be removed.

2.3.5 Disposal

Note!

Electronic scrap is special refuse! You must observe local regulations with its disposal!
COMPACTplus/PROFIsafe does not contain any batteries or other materials that would have to be
removed before disposal of the device.
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3 System design and possible uses

3.1 PROFIBUS DP

PROFIBUS is a manufacturer-independent, open field bus standard with a wide range of
applications in the area of production and process automation. Manufacturer independence and
openness are guaranteed by the international standards, EN50170, IEC61158 and IEC61784.
PROFIBUS enables the communication of devices of different manufacturers without special
interface adjustments and is suitable for both fast, time-critical applications and for complex
communications tasks. Continuous technical further developments ensure that PROFIBUS will
continue to be the future-oriented industrial communications system.

RS-485, MBP-IS or fiber optic cables are available as transmission technologies, depending on the
area of application. Up to 126 stations can be connected to PROFIBUS DP, which share the
transmission medium in time division multiplex. The projectable data transmission rate is 9.6 KBd to
12 MBd, whereby the maximum attainable rate is limited by the cable length. The RS485 cabling,
which is used the most, requires a termination of the cable ends with a defined resistance
combination.

Slave 1 Slave 2 Slave n

Master - Token Transfer

PROFIBUS DP

Fig. 3.1-1 PROFIBUS DP functional principle

The bus access is controlled via a master/slave protocol with overlaid token passing.  A master
station generates a request here to a communications-related subordinate slave station, which
reacts to the master request with a reply or acknowledgement telegram. Only the master that
currently owns the token may generate request telegrams. The bus control right is cyclically
exchanged with the token between the master stations. In addition to peer-to-peer communication
between a master and a slave, a master can also generate aptly-named broadcast telegrams (send
to address 127), which are simultaneously received and evaluated by all slaves, but not
acknowledged. In “modular slaves”, slot and channel can also be provided in the PROFIBUS
address – telegram in addition to slave.

PROFIBUS DP recognizes two types of masters:

• Class 1 Master. This is the central component for the polling bus access procedure for the data
exchange with the input-output devices (slaves). It defines the data rate at which the slaves
usually automatically adapt and control the token exchange with other masters. Typical class 1
masters are PLCs and control PCs.

• Class 2 Master. These are mostly used as projecting or visualizing devices and serve as help
tools with the system start and the diagnostics. Several class 2 masters can be operated
simultaneously on PROFIBUS DP.
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The data exchange between class 1 master and slave can be performed cyclic or acyclic.

Cyclic data is read in each bus cycle into the process mapping memory of the master and written
from there into the slaves. A programming is not required, rather there is only a projecting, i.e.
assignment of the data of the master process mapping for the corresponding data in the
PROFIBUS slaves. The PLC program simply accesses the data in the process mapping memory
regardless of whether this data is read in or written out locally in the PLC or via a PROFIBUS slave.
The automatic cyclic exchange is performed by PROFIBUS.

Acyclic data exchanges can be used by the master that has set the parameters of the slave with the
“RD_REC” and “WR_REC” functions. The acyclic data traffic is applied, for example, with the
transfer of parameter sets from the master to COMPACTplus/PROFIsafe (download) and from
COMPACTplus/PROFIsafe to the master (upload). Independently of this, acyclic write and read
commands can also be generated by the user program.

Alarms are a special case in this respect. They are registered within the cyclic data traffic in the
PROFIBUS status byte with the master, which collects the actual alarm information from the
registering slave using an acyclic telegram. This information is written by the master in a storage
area reserved for alarms (SAP51) and can be evaluated by the application program.

An aptly-named device description data file GSD is required for projecting each PROFIBUS DP
class 1 master and each slave. It is delivered by the master and slave manufacturer and describes
their properties from the PROFIBUS point of view.

3.2 PROFIsafe

PROFIsafe is a functional extension of PROFIBUS DP and it enables safe bus components to be
operated together with non-safe standard components on the same bus. PROFIsafe devices do not
require any changes in the existing hardware components and can be added to existing systems
without any difficulty.

The PROFIsafe driver is a TÜV-certified software component. It sits at the top of the communication
layers on the PROFIBUS DP stack. The safety of the data transfer is achieved with a special
structure of the user data, in which, in addition to the actual safety data a control byte, a sequential
number and an additional check sum are embedded, among others. The aptly-named F-Destination
address enables the unambiguous addressing of a PROFIsafe device, including in systems with
several PROFIBUS strands, therefore possibly with several slave addresses for the same kind of
devices.  Only the cyclic data is safely transferred, i.e. processed by the PROFIsafe driver before or
after the transfer.

Warning!

Because only the OSSD bit is safely = 0 also in case of failures, the other cyclic input data must
only be used for safety relevant purposes in the safety PLC, if the OSSD-Bit = 1.

Acyclically read or written data is not transferred safely and must therefore not be used for safety
elevant purposes.
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3.3 COMPACTplus/PROFIsafe

COMPACTplus are type 4 active opto-electronic protective devices. They consist of a number of
light beams that are synchronized with one another, which either consist of a transmitter and a
receiver unit or a transceiver unit and a deflecting mirror so that the light beam devices form a
rectangular protective field. The difference is made between:

• Safety light curtains with 14 or 30 mm resolution for vertical danger point safeguarding.

• Safety light curtains with a preferred 50 or 90 mm resolution for horizontal danger area
safeguarding.

• 2, 3 and 4-beam multiple light beam safety devices and muting transceivers for vertical access
guarding and perimeter guarding.

Various function packages, such as

• “Blanking” for applications with beam blanking,

• “Muting” for brief usage-appropriate bridging of the protective field, in order, for example, to
enable material transport through the protective device or

• “Cycle control” for safety-relevant control of a machine

are used for the optimum adjustment to the respective technological requirements.

Each COMPACTplus receiver and transceiver has a local interface for connecting control, operating
and display elements, which are located close to the protective device, and a machine interface for
the integration into the machine’s main control circuit. The machine interfaces with

• Transistor output

• Relay output

• ASIsafe, AS-Interface Safety at Work

are described in the connecting and operating instructions for the individual function packages.

Note!

Because of the complexity of the PROFIsafe Interface, this connecting and operating instructions
for receivers with PROFIsafe connection is provided separately and replaces the description of the
machine interfaces in chapter 7 of the connecting and operating instructions for the respective
function packages.
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4 Function

COMPACTplus/PROFIsafe receivers supports both, the cyclic and acyclic, data transfer. Cyclic
means that in every bus cycle, input and output data is exchanged between the safe master and
COMPACTplus/PROFIsafe. The description of input and output data refers here to the perspective
of the PROFIsafe master.

• Input data is read by the master, therefore it is the output data of the COMPACTplus Receiver.

• Output data is written by the master and is therefore control signals for the COMPACTplus
Receiver.

COMPACTplus/PROFIsafe also supports the acyclic commands RD_REC and WR_REC in order to
be able to transport larger data blocks with a master on request, without constantly loading the
cyclic real-time operation heavily.

4.1 Cyclic data exchange

The cyclic data traffic is started following successful setup of the connection with the master. The
input data is set to safe values until the receiver has started up and, where required, its parameter
set has been adjusted by the Proxy-FB (see chapter 4.3).

4.1.1 Cyclic input data

The receiver provides the safe master input user data with a 4 byte length. PROFIsafe itself
requires a further 4 bytes, so that 8 bytes must be reserved in the PAE process mapping for the
receiver. The first byte 0 of the cyclic telegram has a fixed structure while the significance of bytes
1, 2 and 3 can be changed with SafetyLab up from version 1.1. Tab. 4.1-1 shows the factory
setting, which can be used unchanged in many applications. Not only the OSSD state, but rather all
bits are functionally safe and can be further processed by the safe PLC program, when the OSSD
bit = 1. The status signal bits Lx_OUT and Mx_OUT in particular, which with devices with transistor
output, relay output or ASIsafe can exclusively be used as non-safe signal outputs, open up many
new application options in addition to the direct access to internal signals with PROFIsafe.

Warning!

The bit 0.1 (OSSD_STATE) must, however, always be used for releasing the safety circuit, as only
this bit is set safely to 0 when a device fault has occurred. The other cyclic input data can therefore
only be evaluated when the bit OSSD_STATE = 1. The diagnostics information about a device
failure is available in the non-safe standard program; the safe cyclic bits are only passivated.

PROFIsafe also ensures that the delay of the reactivation of this bit is as big as the watchdog time
TWD (chapter 7.1.1) set in the F-CPU, even if a smaller value has been selected with SafetyLab. This
is required to be sure that OSSD switch-off shorter than the cycle time of the F-CPU are detected
by the F-CPU in every case, and a restart interlock that is programmed here switches off safely.
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Byte
.Bit.

Name Meaning

See chapter 4.3 for details.
Signals to the optional Proxy-FB on the F-CPU that a parameter adjustment is
necessary. The bit is set to 0 after the parameter adjustment has begun. If an
error occurs during the adjustment, it goes back to 1. During the parameter
adjustment the bit 0.1 OSSD_STATE is set to 0.
0 Proxy-FB must not perform a parameter adjustment.

0.0 PROXY_
REQUES
T

1 The parameters must be compared between the F_CPU and the
receiver by the Proxy-FB.

Provides the receiver’s safety output state.
0 The safety switching output OSSD is switched off.

0.1 OSSD_
STATE

1 The OSSD is switched on.

Provides the status of the protective field while complying with beam zones
with blanking or reduced resolution.
0 The protective field is not free, i.e.

• normal beams without blanking are interrupted or
• blanked objects are not at the expected position or do not have

the expected size or
• objects in beam zones with reduced resolution are too big.

0.2 PFF

1 The protective field is evaluated as free.

Shows whether at least one beam is weak as the result of bad alignment or
dirt has been detected. The weak beam signal is time-filtered for this over 10
minutes.
0 No dirt or bad alignment.

0.3 DIRTY

1 At least one beam is badly aligned or the front screen is dirty.

Start/restart interlock locked.
0 The start/restart interlock is not locked.

0.4 RSI_
LOCKED

1 The start/restart interlock is locked.

Shows an active connection to a PC with SafetyLab via the optical
parametering and diagnostics interface.
0 No PC with SafetyLab connected.

0.5 PC_CON-
NECTED

1 PC connected with SafetyLab and active connection to the device.

Shows a user error.
0 Normal operation. All connected sensors, display elements and the

cabling are fault-free and correspond with the parametering.

0.6 ERROR

1 User error. The receiver is intact and shows a error code E xx on its
7-segment display; the user must check the activation of the
sensors and signal elements, the cabling and the parametering.

Shows a device error.
0 Normal operation, device is fault-free.

0.7 FAILURE

1 Device fault. The receiver shows a failure code F xx on its 7-
segment display and must be replaced.
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Byte
.Bit.

Name Meaning

Status signal outputs M3, M4 and M5.
Parametering defines which internal signals are given out here. The
assignment can be changed with SafetyLab.
Factory setting for all function packages is:
• M3_OUT: Active protective field free/ready for unlocking; corresponds with

the bits 0.2 and 0.4.
• M4_OUT: Fault/error/dirt collective signal; corresponds with the bits 0.3, 0.6,

0.7.
• M5_OUT: Reserved, no function.
As M3_OUT and M4_OUT are already covered by byte 0, this assignment can
be changed without loss of information with SafetyLab.
0 The signal given out is 0.

1.0
1.1
1.2

M3_OUT
M4_OUT
M5_OUT

1 The signal given out is 1.
Logical signal state of the L1 and L2 inputs while complying with the possible
inverting of the physical signal set with SafetyLab, but without time filtering of
the muting sensor signals; function depends on the function package.
0 Logical input signal is 0.

1.3
1.4

L1_IN
L2_IN

1 Logical input signal is 1.
Status signal output L2; no function in FS; assignment of an internal signal is
possible with SafetyLab.
0 The signal given out is 0.

1.5 L2_OUT

1 The signal given out is 1.
Logical signal state of the TriState input L3 while complying with the possible
inverting of the physical signal set with SafetyLab, but without time filtering of
the muting sensor signals; function depends on the function package.
0 Logical input signal is 0.

1.6 L3_IN0

1 Logical input signal is 1.
Activation of the TriState state of L3 input; only valid if the TriState test has
been activated (depending on function package and setting by SafetyLab).
0 Input is on 24 V or GND.

1.7 L3_IN1

1 Input is open.
2.0 L4_IN0 As bit 1.6 (L3_IN0), but for L4.
2.1 L4_IN1 As bit 1.7 (L3_IN1), but for L4.

Logical signal state of the L5 input while complying with the possible inverting
of the physical signal set with SafetyLab; factory setting for all function
packages is “Input local start button”.
0 Logical input signal is 0.

2.2 L5_IN

1 Logical input signal is 1.
Status signal, L5 output.
Factory setting depends on the function package:
• Blanking: “Teach in Override” activated.
• Muting: Muting activated.
• Cycle control: Number of remaining cycle interventions.
0 The signal given out is 0.

2.3 L5_OUT

1 The signal given out is 1.
Switching state of the additional contact-based safety circuit; signal is log. 1
when not active.
0 The signal given out is 0; safety circuit is parametered and opened.

2.4 ESC

1 The signal given out is 1; safety circuit is closed or not
parametered.

2.5
2.6

BEAM_
SIGNAL1
BEAM_
SIGNAL2

Status of the internal “Beam signal 1” and “Beam signal 2”.
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Byte
.Bit.

Name Meaning

0 No beam has been parametered with “Beam signal x” or no beam
is interrupted with “Beam signal x” parametering.

1 At least one beam has been parametered with “Beam signal x” and
is interrupted.

Internal start/restart interlock is ready for unlocking.
0 The internal start/restart interlock is either not active or not ready

for unlocking.

2.7 UNLOCK-
ABLE

1 The internal start/restart interlock is active and locked. All safety
conditions for unlocking have been met, i.e.
• the active protective field is free (see bit 0.2)
• optional safety circuit is closed (bit 2.4).

3.0
3.1
3.2

OP_
MODE

Shows the currently set operating mode binary coded, only updated in the
“Cycle control” function package with values between 0 and 7, otherwise 0.

Status of the “Teaching-in” function, only updated in the “Blanking” function
package, otherwise 0.
0 “Teaching-in” is not active.

3.3 TI_REQ

1 Teaching-in has been activated, e.g. using SafetyKey, key lock, PC
and SafetyLab or safe PLC via cyclic output bit.

Shows the activation of teaching-in override, only updated in the “Blanking”
function package.
0 Teaching-in override not active.

3.4 OVRD

1 Teaching-in override active.
Shows the activation of muting or bypass, only updated in the “Muting” and
“Cycle control” function package.
0 Muting / Bypass not active.

3.5 MUTING_
ACTIVE

1 Muting / Bypass active.
Shows undercurrent on monitored lamp (L5).
0 Monitored muting lamp on L5 is fault-free.

3.6 MLAMP_
WARN

1 Undercurrent on lamp, output L5.
Muting restart for free-moving of a muting line.
0 Not active.

3.7 MUTING_
RESTART

1 Muting restart has been activated.

Table 4.1-1 Factory setting of the cyclic input bits is identical for all function packages.

4.1.2 Cyclic output data

COMPACTplus/PROFIsafe receivers expects 4-byte output data from the safe master. PROFIsafe
itself requires a further 4 bytes, so that 8 bytes must be reserved in the PAA process mapping for
the receiver.

The data structure itself is fixed; the assignment of this control data can be assigned specific
functions bit-wise with SafetyLab from version 1.1. The first byte 0 is an exception. It is the
parameter set number, which is set by the program in the F-CPU and requests the receiver to use a
specific parameter set defined during the setup of the application, which is saved in the master. The
master can consequently switchover the complete parameter set during the operation in conjunction
with the Proxy-FB. For safety reasons the switchover must be initiated by the safe master. With
detected deviation of the requested parameter set from the currently present parameter set, the
receiver requests its Proxy-FB in the master via the PROXY_REQUEST input bit to send it the
appropriate parameter set. The requested parameter sets must be generated beforehand during the
initial operation and be stored in the storage area of the Proxy-FB on the F-CPU. The following, for
example, can therefore be easily carried out:
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• A protective field switchover.

• Changing of MultiScan factors.

• Activation/deactivation of the internal restart interlock.

• Activation/deactivation of safety circuits.

• Changing the muting types or filter times.

• Switchover of fixed cycle operating modes by the higher level PLC.

• ... As well as all other parameters that can be set via SafetyLab.

If the digit 0 is in the output byte 0, then there is no switchover of the parameters as the Proxy-FB is
deactivated by this; only the set parameter set applies as according to the factory setting, for
example.

The bits M1_IN to M16_IN in the bytes 1 and 2 are available in the receiver for any control
purposes. The assignment of a bit to a control function is made with SafetyLab from version 1.1. It
is used, for example, as

• Start button signal for unlocking the internal start/restart interlock.

• Control signal for protective field parameters, e.g. for program controlled activation and
deactivation of fixed blanking on run-time.

• Muting release signal.

• Muting sensor signal M5.

• Release signal for the last cycle of a cycle control.

The last byte 3 is reserved and has currently no function.

The 4 cyclic output user bytes of the receiver have the following structure:

Byte
.Bit

Symbolic name Meaning

0.0 DATASET_NUMBER _0
0.1 DATASET_NUMBER _1
0.2 DATASET_NUMBER _2
0.3 DATASET_NUMBER _3
0.4 DATASET_NUMBER _4
0.5 DATASET_NUMBER _5
0.6 DATASET_NUMBER _6
0.7 DATASET_NUMBER _7

Bit0 to Bit7: number of the requested parameter set

This byte must be connected with use of the Proxy-FB
(chapter 4.3) with its input DATASET_NUMBER.
The content of this byte must be set in the safe part of the
program.

1.0 M1_IN
1.1 M2_IN
1.2 M3_IN
1.3 M4_IN
1.4 M5_IN
1.5 M6_IN
1.6 M7_IN
1.7 M8_IN
2.0 M9_IN
2.1 M10_IN
2.2 M11_IN
2.3 M12_IN
2.4 M13_IN
2.5 M14_IN
2.6 M15_IN
2.7 M16_IN

Control inputs for any functions in the receiver, the assignment
of which is made with SafetyLab from version 1.1.
Factory setting is:
• M1_IN: “Machine interface input start button”
• M2_IN: “Feedback circuit contactor monitoring input”
• M3_IN to M16_IN: No control function assigned.

3.0
...
3.7

Reserved, currently no function.

Table 4.1-2 Fixed assignment of the cyclic output bits is identical for all function packages.
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4.2 Acyclic data exchange – reading of individual beam data

The acyclic data exchange is used advantageously when relatively rare large data volumes have to
be transferred. The total bus load can consequently be maintained comparably small, which
ensures the real-time behavior of the cyclic telegrams. For the acyclic data transfer, a specific time
slot is reserved between the cyclic telegrams. With the RD_REC and WR_REC commands acyclic
PROFIBUS data can be transferred here in order, for example, to automatically compare the
parameter set or read out individual beam data from the receiver.

Warning!

The acyclic data exchange is not safe. Data that has been read-in via acyclic telegrams must
therefore not be used safety-relevant.

Acyclic reading is only possible via the user program in the master if the following conditions are
met:

• The receiver is in the normal operating mode.

• The optional Proxy-FB has finished the data adjustment. The BUSY output of the Proxy-FB
should be evaluated by the user program for this. As long as the Proxy-FB works, an acyclic
command generated by the user program leads on this receiver to the interruption of the Proxy-
FB with an error message. Acyclic commands generated by the user program must therefore be
synchronized by the user program with the Proxy-FB.

Register 103 (=67hex), slot 1 via RD_REC, is responded for reading out the beam status data. The
reply telegram to this RD_REC has a 10 byte header followed by a variable number of useful data
bytes. The structure of the header is insignificant for the evaluation of the beam data. The up to 31
bytes that follow contain the determined number of beams and the beam status of the up to 240
beams of the receiver, each in one bit per beam.

Byte Meaning
10 Number of

beams
Number of beams actually available in the device; with cascading
devices the sum of all beams of host and guest.

11 ... n Beam states One bit per beam: 0 = beam interrupted, 1 = beam free
Beginning with bit 1.0 for beam 1, … bit 1.7 for beam 8, …

Table 4.2-1 Format of the useful data of the telegram for reading out the individual beam data.

In the user data, from byte 1 on, each beam is assigned one bit. The number of userl bytes n is
calculated according to

n = Int ((number of beams + 7) / 8)

If unused bits remain in the last byte, then these are filled with 0. The correct length of the delivered
data bytes is in byte 10 (number of beams) in the reply telegram.

A program example for reading out the individual beam data can be found in chapter 8.1.5.

Acyclic read and write commands are only accepted if they are correctly received. Faulty
commands are answered with an NRS-PDU. The errors, including the subsequent faulty
communication with the Proxy-FB, are coded as follows:

Error
code

Meaning

0xb0 Inadmissible index (only the indices assigned to the registers are allowed)
0xb1 Inadmissible data set lengths with the writing (the lengths must correspond precisely

with the length of the register)
0xb2 Inadmissible slot (only slot 1 is allowed)
0xb3 Type conflict (false sequential number)
0xb4 Faulty data area (false or unexpected command, e.g. proxy sequence)
0xb5 State conflict (device is not in parametering mode)
0xb6 Access denied (false authorization level)
0xb7 Inadmissible area (inadmissible length with reading)
0xb8 Inadmissible parameters (values for register not allowed)
0xba False CRC value
0xbb False PROFIsafe source address
0xbc False PROFIsafe destination address
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Error
code

Meaning

0xbd DP slot not equal to slot info in header
0xbe DP index not equal to index info in header
0xbf Unknown error (internal error)
0xc2 Resource currently occupied (with teach-in or SafetyLab)
0xca Internal error (I&M)

Table 4.2-2 Error codes in NRS-PDU

These error messages have no influence on the safe cyclic data. An entry in the error memory is
not made and a diagnostics alarm is not activated (see chapter 4.5). The code “b9” is displayed in
the 7-segment display for all of these errors (see chapter 5.1.2). The display is retained until an
error-free telegram has been written or read.

4.3 Proxy Function Block LG_PROXY

The receiver with PROFIsafe Interface can be operated with or without the proxy function block
(Proxy-FB) LG_PROXY. It is sufficient for the safe cyclic data exchange to address the device
correctly and to integrate it into the hardware configuration.

The LG_PROXY Proxy function block works as a “substitute” for a receiver in a safety PLC of the
Siemens S7-300 or S7-400 series. It runs in the standard part of the user program and administers
the parameter adjustment between the receiver with PROFIsafe interface and the F-CPU, so that
an automatic parametering is possible when exchanging a device. The advantage in user programs
that have the Proxy-FB integrated is that the necessary parametering can be performed
automatically when exchanging a device and the maintenance personnel must therefore only set
the correct PROFIBUS address on the hex-switches in the connection cap.

A complete re-parametering of the receiver during run-time is also possible within seconds by the
PLC loading a parameter set (DATASET_NUMBER) requested by the user program in the device
and therefore realizing, for example, protective field switchovers. The LG_PROXY’s task here is to
administer the parameter sets on the PLC. This is performed in the non-safe part of the PLC
program via acyclic writing and reading. The user must store the parameter set number in the first
cyclic output byte via a safe selection procedure in the safety program. Notes on the programming
with Distributed Safety can be found in the “S7 Distributed Safety – Projecting und Programming”
manual.

The parameter exchange is possible in both directions, from the PLC to the receiver and vice versa.
The complete parameter set, which can be set with the optional diagnostics and parametering
software, SafetyLab, as well as other data that ensures that the correct device is connected are
adjusted and switched over here.

One instance of the LG_PROXY must be provided per receiver. It can be used for the following
CPUs:

• S7-315F

• S7-317F

• S7-416F

The Proxy-FB only exists in one version, although the memory models of the individual CPUs are
very different. LG_PROXY checks in which CPU it runs and automatically sets itself on the memory
model of the respective CPU.

Note!

The integration of the LG_PROXY is not beneficial if the receiver is parametered with DIP switches,
as in this case the parameters loaded per software are not accepted and the receiver goes to error
E17. LG_PROXY forces the resetting of the cyclic input data to zero if all switches are not set to
position L.

With use of the “LG_PROXY” functions module, 2 retentive bytes must be reserved per parameter
set. The start address of the retentive bytes is communicated to the LG_PROXY via the
START_ADDR_RETENTIVITY_M input.
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Example: Definition of the requirement for remanent flags

4 parameter sets

x 2 retentive bytes

______________________________________

= 8 retentive bytes

The starting point must be added before the number of retentive bytes is entered in the HW config,
e.g.:

8 retentive bytes

+ 10 starting point

_________________________________________________________

= 18 number of retentive bytes from byte 0

If several COMPACTplus/PROFIsafe are installed in one PROFIBUS system and several
LG_PROXY are used in the F-CPU, then these should be synchronized with one another in order to
prevent overruns of the cycle time of the user program with simultaneous activation of several
parameter adjustment processes. To do this the PROXY_START_ENABLE inputs and the BUSY
outputs (the parameter adjustment is running) of all LG_PROXY can be linked in such a way that
only one LG_PROXY is released at one time. (Chapter 8.1.4)

The parameter sets are stored in the DBs. Depending on the number of parameter sets to be
administered, two different size DB types can be used. While the smaller DB with 16 KByte takes
up to 4 parameter sets and is therefore adapted to the memory model of the S7-315F, the larger for
S7-317F and S7-416F in 64 KByte can store up to 16 parameter sets. The definition of the block
sizes is made in DATASET_PER_DB.

Note!

It must be ensured that a sufficiently big data module is available for the Proxy-FB:

• 16 KByte for S7-315F (DATASET_PER_DB = 0)

• 64 KByte for S7-317F and S7-416F (DATASET_PER_DB = 1)

If several DMs are required, then these must be located in a closed tape, the number of which is
communicated to the Proxy-FB via the input value, RANGE_OF_DB.

LG_PROXY is also delivered with the example project on the CD; the USER password in both
cases (CPU and user program) is "cust". If the LG_PROXY is used with the 416F CPU, the data
modules for the data records cannot be set to "UNLINKED"; with 300 F-CPUs it is better to set the
data modules for data records to "UNLINKED".

LG_PROXY uses SFCs for the communication via PROFIBUS. Error messages of these SFCs and
error codes of the LG_PROXY are provided to the user program via ERROR_NUMBER_FB and
ERROR_CODE_SFC. If the parameter ERROR_CODE_SFC is not equal to zero, the
corresponding SFC can be determined using ERROR_NUMBER_FB in the following table. The
decryption of the SFC error code is possible with the SIMATIC reference handbook “System
software for S7-300/400 system and standard functions”.



20 COMPACTplus/PROFIsafe Leuze electronic

LG_PROXY expects the following input variables (IN) and delivers the following output variables
(OUT):

Parameter Declaration Data type Initial value
Description

DATASET_NUMBER IN BYTE B#16#0
Input for the number of the parameter set (maximum 255) must always be linked with the
first byte of the safe cyclic output data.
The value “0” means that the Proxy-FB is not used.

PROXY_REQUEST IN BOOL FALSE
Input for the Proxy_Request-Bit is linked directly with the corresponding safe cyclic input bit
“0.0”.

PROXY_START_ENABLE IN BOOL FALSE
Allows the release and temporary blocking of the “LG_PROXY” FB, e.g. via the BUSY
signal of an already active LG_PROXY. It can consequently be ensured that only one
LG_PROXY works at one time in order not to influence the cycle time too heavily after
switching on.
0 = LG_PROXY blocked
1 = LG_PROXY released

WRITE_DISABLE IN BOOL FALSE
Prevents data records in the PLC from being overwritten, e.g. in order not to take over later
manipulations to the parameters of the receiver.
0 = No write protection
1 = Write protection activated

DATASET_PER_DB IN BOOL FALSE
Decides which DB type is to be used for saving the parameter sets
0 = 4 data records per DB (S7-315F)
1 = 16 data records per DB (S7-317F, S7-416F)

FIRST_DB IN WORD W#16#0
Number of the first parameter set DB
(e.g. 64 hex  DB 100 is the first parameter set DB)

RANGE_OF_DB IN BYTE B#16#0
Number of DBs available for accepting the parameter sets;
3 hex  3 DBs are available for data records)

START_ADDR_RETENTIVIT
Y_M

IN WORD W#16#0

Limits of the retentive bytes used by LG_PROXY; (A hex  10 retentive bytes are used)
IN_OUT_ADDRESS IN WORD W#16#0

Input/output byte address of the receiver in the process mapping, PAE/PAA
(A hex  The receiver writes the 4 cyclic input bytes from PAE address 10 and reads its 4
cyclic output bytes from PAA address 10)

BUSY OUT BOOL FALSE
Display of the activity state of the FB; can be used in conjunction with the
PROXY_START_ENABLE inputs of other FBs for controlling the processing sequence and
limitation of the cycle time
0 = Not active
1 = Active

STATE OUT BYTE B#16#0
Display of the device state
Code Description
0 No error
1 Data invalid
2 Read data, PLC •  LG
3 Write data, PLC •  LG
4 Process successfully completed
5 Write CRC, PLC •  LG
9 Timeout of 20s exceeded
10 to 52 Error at position xx in the sequence
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Parameter Declaration Data type Initial value
Description

ERROR_NUMBER_FB OUT WORD W#16#0
The FB’s error code can be decrypted using the following table. If an RET_VAL is at the
ERROR_CODE_SFC output in case of an error, the option exists here of determining the
correct SFC and reading the appropriate help text into the respective SFC descriptions.
Error
code Description

101 SFC 51 error, look up error message in the help
102 CPU 3xx or 4xx could not be identified
201 DATASET_NUMBER has been described with the value "0"
202 The DB access is no longer in the parameterized DB area
203 SFC 83 error, look up error message in the help
204 SFC 20 error, look up error message in the help
301 SFC 59 error, look up error message in the help
401 SFC xx error, enquiry about error message with the manufacturer
402 SFC 58 error, look up error message in the help
501 SFC 59 error, look up error message in the help

502
Overwriting the parameter sets in the PLC is not possible, ("WRITE_DISABLE"
is set).

503 Data or decision code invalid; LG_PROXY is terminated
601 Error in LG_PROXY
701 SFC 58 error, look up error message in the help
801 SFC 59 error, look up error message in the help
901 SFC 84 error, look up error message in the help
902 SFC 20 error, look up error message in the help
1001 SFC 58 error, look up error message in the help
1101 SFC xx error, enquire about error message with the manufacturer
1102 SFC 58 error, look up error message in the help

ERROR_CODE_SFC OUT WORD W#16#0
Display for the RET_VAL in the event of an error, the correct SFC can be determined using
the table above.

Table 4.3.-1 Inputs and outputs of the LG_PROXY functions module

Activation of the LG_PROXY is performed by setting the PROXY_REQUEST bit (bit 0.0) in the
cyclic input data by the receiver. As this bit must be linked with the PROXY_REQUEST input of the
LG_PROXY, this now starts with the parameter adjustment. This happens,

• after the receiver has been switched on; if required, download of the PLC after a device
exchange.

• after the teaching-in using SafetyKey or key lock with devices with the “Blanking” function
package, upload of the new parameter set with changed protective field.

• after the parametering has ended with SafetyLab version 1.1 or higher, upload of a modified
parameter set.

• with switchover of the parameter set by the PLC, download of the parameter set requested by
the safe PLC program.

If the parameter set is switched over by the failsafe program while the receiver is in the
parametering mode (with SafetyLab or by teaching-in), then the cyclic input data is set to zero.
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4.4 Identification & maintenance functions

I&M is a concept for manufacturer- and sector-independent standardized identification of field
devices. The field device provides specific information in an electronic nameplate, which can be
primarily accessed online with initial operation and maintenance. The access to the data of the field
device is made via the acyclic DP-V1 access mechanisms RD_REC and WR_REC with fixed index
255 and slot 1. The reading and writing is made on an I&M parameter set consisting of 64 bytes.

The receiver supports the I&M functions I&M0 to I&M4 for master class 1 and 2. The I&M registers
are written acyclic via slot 1 and index 255 with WR_REC and read with RD_REC. The access is
only possible via PROFIBUS, i.e. the values given below cannot be entered by the user with
SafetyLab.

I&M0 (IM_INDEX 65000) Bytes Meaning
Manufacturer-specific 10 Not used (0)

MANUFACTURER_ID 2 294 for Leuze electronic

ORDER_ID 20 Device order number

SERIAL_NUMBER 16 Device serial number

HARDWARE_REVISION 2 Hardware version of the receiver is displayed as with
SafetyLab, e.g. 12

SOFTWARE_REVISION 4 Firmware version of the receiver is displayed as with
SafetyLab, e.g. “V4.20”

REVISION_COUNTER 2 Counts every re-parametering with SafetyLab or by
teaching-in the protective field, but not the parameter
download by the Proxy-FB

PROFILE_ID 2 0x3E00

PROFILE_SPECIFIC_TYPE 2 0x0000

IM_VERSION 2 1.0

IM_SUPPORTED 2 I&M0 to I&M4 (0x001e)

I&M1 (IM_INDEX 65001) Bytes Meaning Pre-emption
Manufacturer-specific 10 Not used 0

TAG_FUNCTION 32 Text Space

TAG_LOCATION 22 Text Space

I&M2 (IM_INDEX 65002) Bytes Meaning Pre-emption
Manufacturer-specific 10 Not used 0

INSTALLATION_DATE 16 Text Space

RESERVED 38 Text Space

I&M3 (IM_INDEX 65003) Bytes Meaning Pre-emption
Manufacturer-specific 10 Not used 0

DESCRIPTOR 54 Text Space

I&M4 (IM_INDEX 65004) Bytes Meaning Pre-emption
Manufacturer-specific 10 Not used 0

SIGNATURE 54 Binary 0

Table 4.4-1 Supported I&M functions

The I&M0 register can only be read by the user, while the I&M1 to I&M4 registers can be read and
written by the user. Each access to these registers is made by a WR_REC call with a subsequent
RD_REC call. An access is terminated after the RD_REC call; before this the values are not
accepted by the receiver.

As two masters can access the I&M register at the same time, it is ensured that with an access,
WR_REC and RD_REC call come from the same master; the second master to access receives the
BUSY error message.

An RD_REC call without a previous WR_REC call is also answered with an error message. A
possibly unterminated access is interrupted by a new complete one.

The acyclic data exchange with the receiver is not influenced by access to the I&M register.
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Note!

The writeable I&M registers I&M1 to I&M4 are not safed by the Proxy-FB. After a device exchange
this data must therefore by written into the replacement device again.

4.5 Alarms

Diagnostics Alarm
The diagnostics alarm is switched off as standard and can be switched on as required via the
parametering.

Errors or warnings from the receiver are reported via the PROFIBUS as diagnostics alarms. Each
new error is messaged as a new occurring alarm. Constantly present errors with standing
connection are only messaged once. With connection interruption and renewed transfer to the cyclic
data traffic, the last error that occurred is reported again as a coming alarm, if it is still present. A
short-term occurring external error (error message Ex xx) is present for at least 10s; a SoftReset is
then performed (PROFIsafe continues to run). If the error is not more present after the SoftReset,
then a going alarm is sent. Serious internal errors can possibly no longer activate an alarm. The
sequence mode for 8 alarms is supported, which means up to 8 alarms are intermediately stored in
the PROFIBUS slave until they have been processed by the PROFIBUS master. The alarm PDU is
coded as follows:

Bit number MeaningBy-
te 7 6 5 4 3 2 1 0
1 0 0 0 0 1 1 0 1 Length of alarm PDU incl. header regardless of alarm

2 0 0 0 0 0 0 0 1 Type is diagnostics alarm

3 0 0 0 0 0 0 0 0 No slots (slot 0)

4 0 0 Sequ.
no.

1 0 0 No alarm differentiation, with acknowledgement, sequence no. 0-7

5 x x x x x x x x Failure or error code as displayed in the 7-segment display of the
receiver

6 0 0 0 0 0 0 0 x x=0: Byte 5 is an error code Ex xx (user / application error)
x=1: Byte 5 is a failure code Fx xx (device failed)

Table 4.5-1 Alarm PDU of the COMPACTplus Receiver

Update Alarm
The update alarm is switched off as standard and can be switched on as required via the
parametering. If a class 2 master is accessed after a C2 initiate for the first time writing on the
receiver, this is communicated to the class 1 master via the update alarm. The alarm PDU is coded
as follows:

Bit number MeaningBy-
te 7 6 5 4 3 2 1 0
1 0 0 0 0 0 1 0 0 Length of the alarm PDU (including header), 4 bytes

2 0 0 0 0 0 1 1 0 Type is update alarm

3 0 0 0 0 0 0 0 0 No slots (slot 0)

4 0 0 Sequ. Nr 1 0 0 No alarm differentiation, with acknowledgement, sequence no. 0-7

Table 4.5-2 Update alarm of the COMPACTplus Receiver
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5 Display elements

5.1 Display on the receiver

5.1.1 LEDs

In addition to the LEDs in the display area of the receiver, the display of which is independent of the
function package and is described in the connecting and operating instructions for the function
package, two LEDs with the following meaning are also available at the front in the PROFIBUS
connection cap.

LED Meaning
Red State of the connection with PROFIBUS.

OFF: PROFIBUS connection is set up.
ON: Receiver is not ready yet.
Flickering (approx. 10 Hz): Receiver is waiting for PROFIBUS connection setup
Flashing (approx. 2 Hz): Internal error in the receiver, bus operation not possible.

Green Function of the bus termination integrated into the connection cap.
OFF: Bus termination switched off (factory setting).
ON:  Bus termination switched on.

Table 5.1-1 LED in the connection cap

5.1.2 7-segment display

In addition to the permanent display types described in the connecting and operating instructions for
the function package and in the SafetyLab operating instructions, the PROFIBUS receiver’s 7-
segment display can,

• display the number of the selected parameter set, which can be switched over via the safe PLC
program and the Proxy-FB.

• display the PROFIBUS address, which is set via 2 hexadecimal switches in the connection cap.

This display must be selected in SafetyLab from version 1.1 as permanent display so that it appears
constantly on the 7-segment display after the startup.

Regardless of this, the PROFIBUS address is briefly displayed during the startup directly after the
auto-test (display “88”) with the display code “Ax xx”, whereby “x xx” is the decimally presented
value of the PROFIBUS address.

Note!

The red/green LED in the receiver display for displaying the switching status of the OSSD safety
output is independent of the type of connection. While it can be assumed, for example, that in a
device with relay output with switched on green LED the relays are actually switched on and
therefore the load circuit is closed, with a PROFIsafe device the data transfer can be damaged, so
that the OSSD bit does not reach the F-CPU, although the green LED signals the “OSSD on” state.

Errors of this kind are shown on the 7-segment display with the display code “b” followed by a digit.
The effects on the cyclic input data (see chapter 4.1), which is delivered by the receiver to the PLC,
depend on the type of error.
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MeaningCode
Effect on cyclic data (OSSD)
False sequential number or false CRC2 in the cyclic datab 1
Are passivated
PROFIsafe watchdog timeout has expiredb 2
Are passivated
The PLC has set failsafe valuesb 3
Are processed in the PLC as 0
PROXY_REQUEST is set and the Proxy-FB is not yet started or not yet terminated
(there may still be invalid parameters in the receiver)

b 4

Are set to 0

At least one of the DIP switches is not in the left position “L”, the download of the Proxy-
FB generates “E17”.

b 5

Are set to 0
The function package of the parameter set to be loaded by the Proxy-FB does not suit
the receiver connected to it

b 6

Are set to 0
The number of beams of the connected receiver does not concur with the parameter set
of the Proxy-FB.

b 7

Are set to 0
There is no valid parameter set in the Proxy-FB; the receiver must be parametered again.b 8
Are set to 0
The last acyclic command was faulty and was not processed.b 9
None.

Table 5.1-2 PROFIBUS fault codes, causes and reactions

5.2 SafetyLab Software

The SafetyLab PC software is used for local diagnostics and parametering and is connected via the
opto-magnetic interface of the receiver above the 7-segment display, and with the cable delivered
with the software via an RS232 interface. The cable of the PC adapter on the receiver goes in the
direction of the connection cap. A strong magnet in the PC adapter ensures not just for mechanism
stops, but also signals the receiver at the same time that the PC adapter is connected.

All displays and settings in devices without PROFIsafe Interface are also possible in the
corresponding PROFIsafe receivers. Furthermore, 16 cyclic output bits, M1 to M16, are also
available instead of just five control inputs, M1 to M5 in the receivers with conventional connection.

In the diagnostics mode SafetyLab from version V1.1 displays the received and sent cyclic data on
a separate “PROFIBUS” register card.

Although the factory setting of the cyclic input data has been selected so that in many cases a
change to the data structure is not necessary (chapter 4.1), the assignment of the bits in the bytes 1
to 3 for internal signals can be changed via the PROFIsafe parametering. Very specific adjustments
to the application are consequently possible.

Note!

Only SafetyLab from version V1.1 can be used for parametering, as older versions do not link with
the PROFIsafe Receiver. A detailed description of the software can be found in the SafetyLab
operating manual.
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6 Installation and connection

COMPACTplus/PROFIsafe Receivers have an integrated PROFIsafe Interface, i.e. all components
for safe connection to PROFIBUS DP are contained in the device; a separate connection unit is
therefore not required. The connection to PROFIBUS is made via cable tails with M12 connection
technology. As PROFIBUS must be looped through the device because of the high 12 MBd data
rate, a PROFIBUS input cable and a PROFIBUS output cable and a 24 V power supply cable are
required per unit.

Unaffected by the PROFIsafe connection, the local interface remains in its versions in accordance
with chapter 7.1 of the connecting and operating instructions of the device, to which the control and
indication signals must be connected, depending on the function package.

The installation using sliding nuts and mounting brackets or in a device column is performed
identically to that of a device with conventional connection, which is also described in the
connecting and operating instructions for the function packages.

The PROFIBUS address must be set before installation of the device. After the connection cap has
been removed, the two hexadecimal switches, HexH and HexL are accessible, with which the
PROFIBUS address can be set. HexL sets the lower-value 4 bit; HexH the higher-value 4 bit of the
PROFIBUS address. Addresses above decimal 126 (Hex 7E) are inadmissible. This is prevented by
the highest value bit 7 not being evaluated. The settings 127 (Hex 7F) and 255 (Hex FF) must not
be used. The factory setting is address 4.

The PROFIBUS address set is displayed by the receiver with the start-up on its 7-segment display
with “Ax xx” and can be optionally selected with SafetyLab from version V1.1 as permanent display.

Warning!

The aptly-named F_Destinationaddress required for the PROFIsafe protocol must not be set
separately, but rather results from the PROFIBUS address + 1000. The user must therefore ensure
that every receiver in every one of the PROFIBUS strands that are connected with one another has
another PROFIBUS address.

The following value must therefore be set in the engineering tools:

F_Dest_Add = ((HexH * 16 )+ HexL) + 1000

The bus termination can be switched on in the connection cap via a slide switch. The switched on
green LED on the front of the cap displays the activated bus termination.

a = Hexadecimal switch, HexH
b = Hexadecimal switch, HexL
c = Slide switch for the PROFIBUS termination shown in position “On”; left = position “Off”
Fig. 6.0-1 Addressing and bus termination

The connection to PROFIBUS and the power supply is performed via cable tails with M12
connection plugs and sockets.
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a = LED red, diagnostics of the PROFIBUS connection via flashing codes
b = LED green, PROFIBUS display, bus termination activated
Fig. 6.0-2 Connection of the PROFIsafe Receiver

Plug / socket assignmentPin
Plug 1 Plug 2 Socket 3

Power supply PROFIBUS
input

PROFIBUS
output

Length: 0.6 m Length: 0.4 m Length: 0.2 m
Pin 1 24 V DC +-20% n.c. n.c.
Pin 2 n.c. RXD/TXD-N RXD/TXD-N
Pin 3 0VDC n.c. n.c.
Pin 4 n.c. RXD/TXD-P RXD/TXD-P
Pin 5 FE Shield Shield
Thread n.c. Shield Shield

Table 6.0-1 PROFIsafe Receiver connection assignment

The receiver must be supplied with 24 V DC via plug 1. Suitable cables, optionally shielded, can be
found in the accessories (chapter 11.2).

Shielded standard PROFIBUS cables with the appropriate b-coded M12 PROFIBUS plug/socket
must be connected to plug 2 and socket 3. If the receiver is the last device on the PROFIBUS
strand, then the internal switch for the bus termination must be switched over; the green LED lights
in this case.
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7 Setting-up the F-CPU

In principle the receiver can work together with every safty PLC that has a PROFIsafe interface.
The projecting and programming required for integration into a user program is described in the
following on the basis of the S7-300F series and the STEP7 software from Siemens. STEP7
version V5.2 + SP2 or higher is required.

Parametering the receiver can be performed as follows:

• Using switches in the device; see the connecting and operating instructions for the device.

• Using SafetyKey for the “Blanking” function package; the adjustment with the optional Proxy-FB
LG_PROXY is performed after removing the SafetyKey.

• With SafetyLab from version V1.1.

Detailed information in this respect can be found in the connecting and operating instructions for the
device and in the "SafetyLab" operating instructions.

7.1 Setting values

7.1.1 Response time

The safety-relevant response time of a safety circuit on the basis of PROFIsafe results from the
response time of the receiver and the PROFIsafe watchdog time, which is set during the projecting
in accordance with the calculation on the PLC shown below.

Only a calculation formula can be provided here for the response time of the sensor together with
the F-PLC. The specific times depend on the respective application, setup and parametering of the
receiver and the cycle time of the F-CPU and the bus.

TWDmin = 2 * MAX(TInterface, TMaster) + 4 * TBus

TWdmin Minimum projectable PROFIsafe watchdog time in the master.

TInterface Cycle time of the PROFIsafe interface of the receiver = 20 ms.

TMaster Cycle time of the PROFIsafe program part on the PLC (mostly determined by OB35).

TBus Cycle time of the PROFIBUS; depends on baud rate, number of slaves, etc.

The PROFIsafe watchdog time TWD projected on the PLC must be set to values greater than TWDmin.
The resolution of the PROFIsafe watchdog time in the receiver is 20 ms, which means that the
actual watchdog time of the receiver can only be integral numbers of a multiple of 20 ms.
Intermediary values must be rounded off (e.g. 41 ms -> 60ms).

The safety-relevant response time consequently results for:

TSR = TPF + TWD

TSR Safety-relevant response time from protective field penetration or bus errors up to the
OSSD bit in the F-CPU is safely switched off.

TPF Response time of the protective field function of the receiver; depends on number of
beams and parametering of multiple scanning and display in SafetyLab, screen
“MultiScan”, see chapter 10.3.

TWD PROFIsafe watchdog time projected in the master.

Warning!

It must be observed that because of the extension of the response time compared with a receiver
without PROFIBUS Interface, mostly greater safety distances are required. In the overall system the
response time of the actor and the stop time of the machine must be taken into account.
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7.1.2 GSD file

The GSD file describes the standard communication parameters of a PROFIBUS device and is
read in by the STEP7 engineering tool. If COMPACTplus cannot be found in the right window of
“HW Config” under

PROFIBUS DP > Additional Field Devices > General
then the GSD must be imported via the menu

Options > Install New GSD ...

7.1.3 F-parameters

The PROFIsafe specification requires the definition of the following F-parameters, which can be
defined for the receiver in the following areas.

F-parameter Meaning
F_Check_SeqNr adjustable as 0 or 1 (default 0)

PROFIsafe V1:
• 0 – the sequential number is not included in the CRC
• 1 – the sequential number is included in the CRC
PROFIsafe V2:
Value not relevant, since the sequential number is always included in the
CRC calculation

F_Check-iPar Cannot be set, fixed on 0 for no i-parameter
F_SIL Cannot be set, fixed on 2 for SIL3.
F_CRC_Length PROFIsafe V1: must be set on 1 for 2 Byte CRC

PROFIsafe V2: must be set on 0 for 3 Byte CRC
F_Block_ID Cannot be set, fixed on 0
F_Par_Version PROFIsafe V1: 0

PROFIsafe V2: 1
F_Source_Add Preset by the F-CPU; from the point of view of the receiver can be set from 1

to 65534.
F_Dest_Add 1000 to 1126 (default 1004).

The F_Dest_Add is formed in the COMPACTplus Receiver from the
PROFIBUS address + 1000 and must be set accordingly in the projecter
tool.

F_WD_Time Safe watchdog monitoring time; can be set in milliseconds of 20 to 1000
(default 20).
The F_WD_Time must always be calculated with the projecting with larger
values according to the formula
           F_WD_Time_min =  2 * max (20ms, tMaster) +
                                            4 * Bus_Cycle_Time
For calculating the response time of the system for the set F_WD_Time, the
response time of the protective field function TPF of the receiver must also be
calculated in accordance with the nameplate and MultiScan factor and
information in SafetyLab (chapter 7.1.1)

F_Par_CRC Must be correctly seized by the PROFIsafe projecting tool with CRC1 for the
F-parameter block.

Table 7.1-1 F-parameters for the COMPACTplus Receiver
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Warning!

As the start value for the CRC calculation of the cyclic PROFIsafe data changes with changes to
the F-parameters, the entire safety program must then be translated and loaded again (chapter
7.3). If parameter sets are already saved by the Proxy-FB, then these must be generated again.
The F-parameters should therefore be correctly set at the beginning of the projecting and then
should be changed as little as possible or not at all.

7.2 Configuring

With the following steps a STEP7 project is created and prepared so that the safe input data of the
receiver in the PAE process mapping of an S7-300F for use by a safe user program is available and
the PAA output data can be written into the receiver. It is a precondition that the PROFIBUS
address of the receiver is already set and known.

Warning!

It must be ensured that the PROFIBUS addresses of all receivers only exist once in the automation
system, as well as in those with several PROFIBUS strands. It is therefore ensured that the
F_Dest_Add (chapter 7.1.3) of each receiver also only appears once system-wide and is therefore
unambiguous.

• Start SIMATIC Manager, if required define new project with the available F-CPU.

• Select “SIMATIC x00” in the tree structure and call up the configuration tool “HW Config” by
double-clicking on “Hardware” in the right window. Change to “HW Config”.

• Define all modules in the rack and at least one PROFIBUS strand.

• Double-clicking on the F-CPU opens its “Properties” window.

• Select on the “Protection” register card the “2. Write Protection” radiobutton, award a password
and select the “CPU Contains Safety Program” checkbox.

• Enter the desired cycle time of the safety program, e.g. 60 ms, on the “Cyclic Interrupt” register
card for OB35. Its influence on the response time of the safety circuit in accordance with chapter
7.1.1 must be observed here.

• On the “Retentive Memory” register card at least the retentive bytes required by the Proxy-FB
must be defined in accordance with chapter 4.3, if the Proxy-FB is to be used.

• From the right window of "HW Config” from “PROFIBUS DP > Additional Field Devices >
General”, drag the COMPACTplus icon on to the PROFIBUS. If COMPACTplus is not available
here then make it available via the menu “Options > Install New GSD ...”.

• Define the PROFIBUS address in “HW Config” per receiver so that it concurs with the setting
per hex switch in the connection cap. To do this open the " Properties DP Slave" window by
double-clicking on the symbol of the COMPACTplus receiver. Set the address here via the
“PROFIBUS...” button and the “Parameters” register card. Close the window by “OK” button.

• Select the receiver with a single click and double click in the table in the lower part of the
window of “HW Config” on the corresponding line for slot 1. On the “Address / ID” register card
define the Start Address of the cyclic bytes in PAE (Input) and PAA (Output) so that they do not
overlap with the memory area of another device. The receiver seizes 8 bytes of input and output
data each. On the “PROFIsafe” register card double click on F_Dest_Add and in the opened
window set the value to “HW Address” + 1000, e.g. 1007 if the address “07” has been set per
hex switch. Set the watchdog time F_WD_Time to a sufficiently large value in accordance with
the calculation formula in chapter 7.1.1, e.g. 150 ms. When setting the cycle time of the
F_Program the response time of the local modules and other PROFIsafe devices must also be
observed. Close the window with the “OK” button.

• Via the menu “Station > Save and Compile” the program structure is defined and the program
container is generated.

• Via the menu “PLC > Download...” or the corresponding button in the toolbar, load the hardware
configuration in the F-CPU. After downloading and re-starting the CPU, no bus errors should be
present  the red LEDs BF 1 and BF 2 on the F-CPU are off.



Leuze electronic COMPACTplus/PROFIsafe 31

7.3 Programming

To evaluate and to generate the safe cyclic data of the receiver in order to write to the receiver
there must be a safety program in the F-CPU. It can only be generated and loaded in the SIMATIC
environment via a special menu and is usually started via the OB35 cyclic interrupt. For a simple
program that firstly serves for displaying the cyclic data in a variables table the following steps are
required after the configuration has been completed:

• In the SIMATIC manager’s tree structure go to “…/S7 Program > Blocks”, click a on free position
in the right window with the right mouse button and select “Insert New Object > Organization
Block > OB35”. Also create OB56, OB82, OB83, ... to OB88 accordingly. The last ones are error
OBs that assure that the CPU does not stop immediately in case of the occurence of certain
errors. Instead, the corresponding error OB is called and a diagnostic alarm is triggered. In
many cases this intercepts the error without stopping the CPU. This is especially interesting
when the CPU controls several independant production lines and the failure of one device
should not influence other lines.

• Highlight modules and via the menu,  “PLC > Download”, load in the F-CPU.

• Define function blocks for the safety program. For this select “Insert New Object > Function
Block”. Define a function module, e.g. FB110 and possibly award a symbolic name. An F-
language must be selected as generation language, F-FBD, for example.

• Create a function, which is called cyclically with the set cycle time in OB35. For this select
“Insert New Object > Function”. Define function as FC1 with the generation language “F-CALL”.

• In the SIMATIC manager open the LAD/STL/FBD editor for OB35 by double-clicking at this icon
and define at least one network with the sub-program call

CALL  FC1

• Save and highlight the defined modules and load them in the F-CPU.

• Call up menu “Options > Edit Safety Program”. In the opened window click on the “Run-time
groups” button and enter a password. In the next window now assign the FB with the safety
program (e.g. FB110) and a data module (e.g. DB110) to the function FC1 or create this first.
Close the window with “OK”.

• Click on the “Compile” button. The generation of the framework for the safety program that has
now started can take some time. The two CRC in the top part of the window must be identical
afterwards.

• Click on the “Download” button to load the safety program framework that has just been created
in the F-CPU.

• In the SIMATIC manager double-click on FC1 and check if FB1 is called up.

• Open FB with the safety program (e.g. FB110) and define a network per receiver for the re-
integration after an error (ACK_REQ  ACK_REI). For this switch the input signal ...ACK_REQ
of the receiver on the output ...ACK_REI via an AND block. This can be performed for sensors
automatically as described, as the safe OSSD signal is routed before the output to an actor via a
restart interlock in the safety program, so that the actor does not start automatically.

Fig. 7.3-1 Re-integration of the PROFIsafe Receiver

• SIMATIC Manager menu “Options > Edit safety program” first “Compil” button, then if fault-free
translated to F-CPU, “Download”.

• In the SIMATIC Manager in the tree structure go to ...\S7 Program > Blocks” . Click on a free
position in the right window with the right mouse button and select “Insert New Object > Variable
Table”. Double-click here and select in the variable table at least the first cyclic input byte of the
PAE of the receiver via menu "Insert > Range of Variables". Animate the variables table via
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menu “Variable > Monitor” or by clicking the corresponding symbol in the toolbar.

With interruption and release of the protective field, at least the bit Ix.2 (PFF) must now change;
with operation without restart interlock also the bit Ix.1 (OSSD_STATE), see chapter 4.1.

For further information see the corresponding documentation on safe programming on STEP7

7.4 Diagnostics data

The diagnostics telegram can be evaluated for checking the status of the connection between the
F-CPU and the receiver. The diagnostics data is delivered as status PDU, in which the following 5
bytes after the first 6 bytes standard diagnostics are delivered.

Bit number MeaningByte
7 6 5 4 3 2 1 0

7 0 0 0 0 0 1 0 1 Length of the PDU status is 5 (including header)

8 1 0 0 0 0 0 0 1 Type is status message

9 0 0 0 0 0 0 0 0 No slots

10 0 0 0 0 0 0 0 0 No status differentiation

11 x x x x x x x x Error in F-parameters (error number)

Diagnostic data in status PDU of the COMPACTplus Receiver

Error numbers for error in F-parameters (byte 11):

0 No error

64 Error with F_Destination Address

65 False F_Destination Address

66 False F_Source Address

67 False F_Watchdog Time setting

68 False SIL setting

69 False CRC length

70 False F_Block_ID or F_ParVersion

71 False CRC1 via the F-parameters

If one of the abovementioned errors occurs, then the connection setup is rejected.

For diagnostics purposes the abovementioned error numbers are also stored in the receiver, so that
they can be displayed via SafetyLab from version 1.1, register card PROFIBUS, line PROFIBUS
Diagnostic.

Errors in the standard parameters can only be detected in the PLC diagnostics or with a bus
monitor, not, however, with SafetyLab.



Leuze electronic COMPACTplus/PROFIsafe 33

8 Initial operation

8.1 Design examples

The following steps for setting up different complex systems are explained using a few examples.
For this purpose the appropriate project for the F-CPU used should be dearchived from the CD-
ROM. If the Proxy-FB is to be used, then it can be simply copied from the appropriate example
project into your own project.

8.1.1 Plug and Play

In simple applications the Proxy-FB can be dispensed with. Only the cyclic data exchange is used
in order to transfer the safe signals. After the PROFIBUS address is set on the receiver, the
receiver connected to PROFIBUS and the PLC program prepared in accordance with chapters 7.2
and 7.3, the safe program part must only be supplemented by the appropriate function blocks. This
is explained using 2 typical applications.

Example 1:

Various protective fields are taught into a light curtain with the “Blanking” function package via a 2-
channel key switch on run-time that is already expected the factory setting on L1 and L2. After a
device exchange the required protective field is taught in again or the parameter plug-in module is
plugged into the replacement device, so that a parameter saving is not required via the Proxy-FB. A
safety door switch (S6=R) is connected on L3 and L4, with which the access to the rear area of the
machine is safe. This safety circuit already acts with the internal linking in the receiver on its OSSD
bit and must therefore no longer be integrated into the switch-off logic in the safety program. The
light curtain runs without internal restart interlock (S3=L), as this is implemented with the safety
program on the F-CPU. The emergency STOP buttons are read in distributed in the system via
ET200S and “AND-ed” to a central switch-off signal, which is integrated in the release circuit of the
machine to be protected. The EDM contactor monitoring is also implemented by the F-CPU, as it
generates the release signal. A static contactor monitoring is shown via an electrical series
connection with the “Acknowledge_Button”. A separate input for the feedback contacts of the
contactors is therefore not provided.

The following program part must also be included in the safety program:

Fig. 8.1-1 Safety program part with restart interlock

A10.2
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Example 2:

A packing machine, e.g. a wrapper, has a switch-off circuit – the main drive of the wrapper, and a
palette run-in and run-out area. Each area is protected by a muting transceiver with deflection
mirror. In addition to the complete muting functionality, each transceiver has its own internal restart
interlock activated in order to enable free-moving after a fault with the local start button, while the
safe program only implements the EDM function. The two OSSD signals must therefore only be
“AND-ed” in the F-CPU for a control signal for the “Wrapper_Enable” main drive. The EDM function
must also be programmed, which is not shown here.

Fig. 8.1-2 Safe program part without restart interlock

8.1.2 Parameter saving via Proxy-FB

If the parameters of the receiver are to be taught in with SafetyKey or set with SafetyLab and these
are automatically loaded in a spare device with a device exchange, then the integration of the
Proxy-FB LG_PROXY in the standard part of the PLC program is necessary. All DIP switches in the
device must be in the factory delivery position "L" so that the receiver accepts the data of the Proxy-
FB. Proceed as follows for the integration of the Proxy-FB in your PLC program:

• Integrate example library of the supplied CD-ROM via menu File > Retrieve and save under
Step7 > S7LIBS.

• Open example project, copy LG_PROXY and add to the target project (e.g. as FB10).

• Open OB1 in the standard program, add new network and drag from “Blocks” into the network.

• Define instance DB (e.g. DB10) and select the “unlinked” checkbox.

• Double-click on the DB and give as type ARRAY[0..16383] for the small memory area with 4
parameter sets per DB and BYTE under this; for large blocks for up to 16 parameter sets select
ARRAY[0..65535].

• In the safety program (e.g. in FB110) set output byte DATASET_NUMBER fix to 1. Exactly one
parameter set is consequently available for the receiver.



Leuze electronic COMPACTplus/PROFIsafe 35

• Prepare some input bits in the standard program before calling the Proxy-FB:

SET

    =     M   1000.0

CLR

    =     M   1000.1

CLR

    =     M   1000.2

• Call the Proxy-FB in OB1:

CALL  "LG_PROXY" , DB10

      DATASET_NUMBER :=AB0

       PROXY_REQUEST :=E0.0

      PROXY_START_ENABLE :=M1000.0

       WRITE_DISABLE :=M1000.1

       DATASET_PER_DB :=M1000.2

       FIRST_DB :=W#16#64

       RANGE_OF_DB :=B#16#1

       START_ADDR_RETENTIVITY_M :=W#16#14

      IN_OUT_ADDRESS :=W#16#0

BUSY :="LG_PROXY BUSY"

STATE :="LG_PROXY STATUS"

       ERROR_NUMBER_FB :="LG_PROXY ENBR FB"

ERROR_CODE_SFC :="LG_PROXY ECODE FC"

It is assumed for the abovementioned FB call that the cyclic bytes begin from address 0 in the PAE
and PAA  the number of the selected parameter set is in the first output byte AB0, the
PROXY_REQUEST bit is in the cyclic input bit E0.0.

If the parametering of the receiver is changed by teaching in with SafetyKey or with SafetyLab, then
the new parameter set is automatically saved by the Proxy-FB on the F-CPU. For this the receiver
signals the Proxy-FB via the PROXY_REQUEST bit that new data is ready for being backed-up.
This reads it transparently for the user from the receiver and saves the parameter set.

8.1.3 Parameter switchover

In order to switch over the parameter set during run-time, the Proxy-FB must be integrated in
accordance with chapter 8.1.2 and the number of the parameter set to be selected must also be
changed depending on the current processing step

• via the input DATASET_NUMBER of the Proxy FB

• and therefore simultaneously via the safe cyclic output byte 0 (chapter 4.1.2).

The receiver recognizes the change compared with the previously saved parameter set and
requests a parameter set that is appropriate for the new number from the Proxy-FB via the
PROXY_REQUEST bit. The Proxy-FB reacts to this by downloading the requested parameter set.

Warning!

During the download the OSSD bit is set to 0. The parameter switchover is therefore suitable for
adjustment to different work pieces after a brief stop phase (a few seconds), but not however for the
switchover of the protective field during a dangerous movement, which continuously requires
OSSD_STATE = 1.
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Warning!

It is the task of the safe program to ensure that the correct parameter set is selected for the correct
time and is available as a numerical value between 1 and 255.

Before the parameter set of the receiver can be switched over on run-time, all parameter sets must
be defined and checked in the receiver during the initial setup phase so that they can then be taken
over into the F-CPU. The following procedure is necessary for each parameter set for this purpose:

• The F-CPU presets a parameter set number DATASET_NUMBER in the safe program. The
selection is made, as it is done later on run-time of the application.

• The receiver must now be parametered by teaching-in via SafetyKey or using SafetyLab from
version 1.1. in the usual way.

• After the parametering has been completed the parameter set is taken over by the Proxy-FB
into the F-CPU.

For conveniently checking the selection of the current parameter set on run-time its number can be
shown on the 7-segment display as permanent display. The selection of this type of display is made
via SafetyLab.

Note!

The user data (user name and password) is also adjusted as parameters of the receiver by the
Proxy-FB. With generation of the parameter sets it must therefore be ensured that all users are
defined first. The definition of a new user after some parameter sets have already been saved by
the Proxy-FB therefore requires that the already stored parameter sets are saved again with the
new user. Otherwise the new user can only access those parameter sets for which he has been
defined.

8.1.4 Administration of several Proxy-FBs

Each COMPACTplus / PROFIsafe receiver requires its own Proxy-FB in the non-safe user program.
Heavy loading of PROFIBUS and user programs can in particular occur with the start up of a large
system with many Proxy-FBs, as all receivers try to compare their parameter sets with their Proxy-
FBs at the same time  the danger of exceeding the permitted cycle time is great.

In order to keep the load low and to also control the sequence of the start-up, the Proxy-FBs can be
controlled so that only one Proxy-FB works at any one time. If the adjustment with its receiver has
finished, it releases the next Proxy-FB. The control is performed via the inputs
PROXY_START_ENABLE and the outputs BUSY. The “PROXY MANAGEMENT” function to be
created by the user must read in all BUSY outputs and check if one of the bits = 1. If this is the case
then the “PROXY_START_ENABLE” inputs of all inactive Proxy-FBs must be set = 0; only the
control input of the currently active LG_PROXY remains = 1. If all BUSY outputs = 0 all
“PROXY_START_ENABLE” inputs are set = 1.

 

LG_PROXY 
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PROXY_START 
_ENABLE 

BUSY 

LG_PROXY
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PROXY_START
_ENABLE

BUSY
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Fig. 8.1-3 Administration of the activation of several LG_PROXY
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8.1.5 Reading individual beam data

In addition to the safety function, which is based on the safe cyclic data exchange, the statuses of
the individual beams of the receiver can be read-out via an acyclic RD_REC call. As the acyclic
data traffic is also used by the Proxy-FB and can be damaged if the parts of the parameter set
expected by the receiver do not arrive in the correct order, the reading out of the individual beam
data must be synchronized with the activation of the Proxy-FB. For this the BUSY output of the
Proxy-FB assigned to the receiver to be read out has to be checked before the call up of RD_REC
in order to prevent the reading out of the individual beam data being performed at the same as an
adjustment with the Proxy-FB, as the parameter adjustment is consequently interrupted. While the
individual beam data is being read out the PROXY_START_ENABLE input of the LG_PROXY
should be set = 0 to securely prevent the proxy activity from starting.

The reading is performed in a DB that has been provided an address and length via the RECORD
parameter. One bit is required per beam. As a light curtain can have a maximum of 240 beams, the
required data block will be a max. of 40 bytes (10 byte header + 30 bytes of 8 bit data). To define
the size, the DB (e.g. DB12) is double-clicked in STEP7 and the type is defined with ARRAY[0..40]
of the type BYTE:

After the control inputs and outputs of the LG_PROXY have been processed, the call-up of the
RD_REC function is performed:

CALL  "RD_REC"

     REQ    :=M10.1

    IOID   :=B#16#54 //54=input or input/output

     LADDR  :=W#16#0 //PAE address of cyclic data = 0

     RECNUM :=B#16#67 //"Register-" index; =103

     RET_VAL :=MW3

     BUSY   :=A16.6 // Display BUSY on output A16.6

     RECORD :=P#DB12.DBX0.0 BYTE40

The REQ input (M10.1 in the example) should be controlled via an edge signal to ensure that only
one individual call is generated.

8.2 Scenarios with Proxy-FB

Without Proxy-FB the parameters with initial setup and with each device exchange must be set with
the help of the methods listed at the beginning of chapter 7. A rapid re-parametering on run- time is
not possible. The scenario is different with the use of the Proxy-FB. The integration of the Proxy-FB
in the standard part of the user program is beneficial when the parametering is performed via
teaching-in with the SafetyKey or using SafetyLab. The following scenarios are then possible:

• Initial setup of a new system.

• Changing of the parametering of a receiver that is known to the master.

• Normal start with a correctly parameterized receiver.

• Switchover of the parametering in normal operation.

• First start after a device exchange.

The behavior of Proxy-FBs in the PLC and the receiver is explained in the following for these cases.
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8.2.1 Initial setup

There are no valid parameter sets available to the Proxy-FB in the PROFIBUS master. The receiver
runs in factory setting and has already been parametered by either teaching-in or using SafetyLab.
The DIP switches must be in the "L" position. It goes to the normal operating mode without the
parameters having to be transferred to the Proxy-FB. The STATE output of the LG_PROXY has the
value 1.

If the factory setting does not correspond with the requirements of the use, the receiver can be
parametered at the usage location via the optical PC adapter with SafetyLab. Case 8.2.2 is then
present.

When setting the receiver via the switches S1...S6 on the parameter module, the integration of the
Proxy-FB is not beneficial as the parameters are neither transferred to the F-CPU nor can they be
loaded by the F-CPU into the device (error message E17).

8.2.2 Parameter change in the receiver

The receiver is re-parametered with connected PROFIBUS by teaching-in with the SafetyKey or
with SafetyLab. After all parameters have been set and checked, the receiver goes to its normal
operating mode with cyclic data exchange.

When the parametering has been completed the new parameter set is sent to the Proxy-FB in the
PROFIBUS master. This parameter adjustment is performed automatically in the background; any
parameter set that may already be saved in the Proxy-FB is overwritten.

8.2.3 Parameter switchover by the F-PLC

The parameter switchover is performed with presetting of the number of the parameter set to be
selected in the cyclic output byte 0. With a change of this value the receiver detects a deviation
from the currently set parameter set and requests a download of the selected parameter set by the
Proxy-FB via the PROXY_REQUEST bit in the cyclic input bit 0.0. This already knows the number
of the requested data set through its input DATASET_NUMBER, provided DATASET_NUMBER is
linked with the first cyclic output byte.

8.2.4 Device exchange

The receiver can be clearly identified using specific internal values. As these values are stored in
the Proxy-FB memory area, a device exchange can be detected. The parameter set saved by the
Proxy-FB is automatically transferred to the receiver. The Proxy-FB saves the new identification
values and goes to the normal operating mode.

If a Proxy-FB has saved a parameter set once, then a new same-model receiver is always
overwritten with the parameter set of the old receiver, as it is thought of as an exchange device. If
work is to be carried out on the already awarded PROFIBUS address with a new receiver and new
parametering, then

• the receiver must first be made known to the Proxy-FB by connecting it to the PROFIBUS. The
old parameter set is automatically transferred to the new receiver.

• the receiver must subsequently be re-parametered using SafetyLab or SafetyKey. If the
parametering has finished, the new parameters are automatically transferred to the Proxy-FB.
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9 Tests

The tests required in the connecting and operating instructions for the individual function packages
apply. These depend on the type of application.

10 Error diagnostic

The receiver distinguishes between error / perturbation codes (Ex xx) and fault / failure codes (Fx
xx). Only error codes provide you with information about events or conditions that you can
eliminate. If the receiver shows a fault code, it must be replaced. For this reason, only error codes
are listed below:

Code Ursache / Bedeutung Maßnahme zur Fehlerbehebung
LEDs and 7-segment displays are not lit Check + 24 V supply voltage (check

for polarity and connection cable).
Replace the receiver if necessary

  8 : 8 Is constantly lit  hardware fault Replace receiver
  F  x(x) Internal hardware failure Replace receiver
  E  1 Short circuit between OSSD1 and OSSD 2 Remove short circuit
  E  2 Overload on OSSD1 Connect correct load
  E  3 Overload on OSSD2 Connect correct load
  E  4 Overvoltage on OSSD1 use correct power supply / load
  E  5 Overvoltage on OSSD2 use correct power supply / load
  E  6 Circuit against GND on OSSD1 remove short circuit
  E  7 Circuit against 24V on OSSD1 Remove short circuit
  E  8 Circuit against GND on OSSD2 Remove short circuit
  E  9 Circuit against 24V on OSSD2 Remove short circuit
  E  10 DIP switch not correctly positioned Correct switch positions
  E  11 Host + Guest(s) longer than 240 beams Connect correct guest device(s)
  E  12 Guest connected on run-time Connect guest(s) and restart
  E  13 Guest removed on run-time Connect guest(s) before power-on
  E  14 Undervoltage at power supply line Check / replace power supply
  E  15 Reflections at configuration interface Protect interface optically
  E  16 Fault on an input or output Connect signal lines correctly
  E  17 Error in parameterization or incorrect switch

setting S1 to S6
Move switch to position L or correct
parameterization with SafetyLab

  E  18 Transmitter test signal received for longer
than 3 seconds

Close jumper between terminal 3 and
4 in transmitter connection cap

  E  20 Electromagnetic interference Interference suppression for power
supply and/or signal lines

  E  21 Electromagnetic interference Interference suppression for power
supply and/or signal lines

  E  22 Overvoltage,  > 31VDC Reduce power supply lower than 31V
  E  30 Feedback contact of external device

monitoring is not opening
Check line or replace contactor

  E  31 Feedback contact of external device
monitoring is not closing

Check line or replace contactor

  E  32 Feedback contact of external device monitor
not closed

Check line or replace contactor

  E  39 Start button pressed too long or line shorted
to 24VDC

Release start button or remove short
circuit to 24VDC

  E  40 Safety circuit on L3/L4 has short to GND Eliminate short
  E  41 Safety circuit on L3/L4 has short to 24VDC Eliminate short
  E  42 Safety circuit on L3/L4: simulaneousness

error
Exchange sensor / safety switch

  E  43 Override circuit on L3/L4 has short to GND Eliminate short
  E  44 Override circuit on L3/L4 has short to 24V Eliminate short
  E  45 Override circuit on L3/L4 not closed Connect override switch
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Code Ursache / Bedeutung Maßnahme zur Fehlerbehebung
  E  46 Override circuit on L3/L4: simulaneousness

error
Exchange switch

  E  50 Muting time limit exceeded Initiate Muting Restart
  E  51 Undercurrent on Muting indicator (L5) Replace or connect correct indicator,

check line between lamp and L5
  E  52 Overcurrent on Muting indicator (L5) Replace or connect correct indicator,

check line between lamp and L5
  E  53 Short circuit or wrong sequence on control

input for muting timer enable signal
Eliminate short or enter correct signal
sequences

  E  54 Override time limit exceeded After AutoReset: device will continue
with normal operation

  E  56 External operating mode selection switch or
jumper not correctly connected

Check connections

  E  70 Display module not compatible with the
receiver’s hardware

Plug in original display module with
correct parameter set

  E  71 Display module not compatible with the
receiver’s firmware

Plug in original display module with
correct parameter set

  E  72 SafetyLab not compatible with the receiver‘s
firmware

Use updated version of SafetyLab

  E  73 Parameter set from Proxy-FB not
compatible with the receiver’s firmware

Setup again the parameter set by
teach-in or SafetyLab and upload to
Proxy-FB

  E  95 Error in beam parameterization Correct beam parameterization by
SafetyLab or teach-in again

  E 177 -
  E 187

PROFIBUS error Contact your manufacturer

Table 10.0-1: Diagnostic receiver
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11 Technical data

11.1 General system data of the PROFIsafe Receiver

Safety category Type 4 in acc. with EN IEC 61496-1
SIL 3 in acc. with IEC 61508

Supply voltage 24 V DC, +-20 %, external power supply with secure
mains supply isolation

Residual ripple of supply voltage ± 5 % within the limits of Uv
Power consumption 150 mA (Uv = 28.8V; +20%)

160 mA (Uv = 24V)
170 mA (Uv= 19.2V; -20%)

Protection type IP65
Ambient temperature, operation 0 ... +50 °C
Ambient temperature, storage -20 ... +60 °C
Relative humidity 15 ... 95 %, without condensation
PROFIBUS data rate 9.6 kBd .. 12 MBd
PROFIBUS connection M12 plug, b-coded
Additional response time of the
PROFIsafe part of the receiver

20 ms

Cable tail lengths PROFIBUS input: 0.4 m
PROFIBUS output: 0.2 m
Power supply: 0.6 m

Power supply cable lengths < 100 m

11.2 PROFIsafe services

Version of the PROFIsafe driver V2, supports PROFIsafe profile V1 and V2
Cyclic data 4 user data bytes of input data

4 user data bytes of output data
Acyclic data For reading out the switching state of the individual

beams
Saving the parameters in the F-CPU Via Proxy-FB module for:

• S7-315F
• S7-317F
• S7-416F

Number of parameter sets; can be
switched over via safe program in the
F-CPU

Max. 255 depending on the available storage space
on the F-CPU

Safety output restart delay The greater of the two values from:
• Watchdog time in the F-CPU + 20 ms
• Restart delay of the receiver
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11.3 Dimensions, weights, response times

While the dimensions and weights correspond with those in the connecting and operating
instructions for the device, the factory setting of the response time of the receiver is 20 ms
(response time of the PROFIsafe Interface) greater than that of the corresponding device with
transistor output. See chapter 7.1.1 for calculation of the overall response time of a safety circuit.
Regardless of the function package, this is provided in the following for all device versions and
corresponds with the value “t xx” on the 7-segment display of the receiver in the factory setting with
the start-up as well as the information on the nameplate. With a change of the multiscan using
SafetyLab from version V1.1 the additional response time is displayed here, which corresponds with
“t xx” with the start-up.

The response time of the protective field required for calculating the response time of the projected
safety circuit is shown separately in the following tables in the column t_PFHx.

11.3.1 Safety light curtains

t_H1 = Response time of the AOPD in ms, MultiScan factor H=1 (FS)
t_PFH1 = Response time of the protective field in ms at H=1 (FS)

Resolution
14 mm

Resolution
30 mm

Resolution
50 mm

Resolution
90 mm

Protective
field height
[mm]

t_H1 tPF_H1 t_H1 t_PFH1 t_H1 t_PFH1 t_H1 t_PFH1
150 25 5 25 5

225 27 7 27 7

300 29 9 25 5

450 32 12 27 7 27 7

600 35 15 29 9 25 5

750 38 18 30 10 26 6 26 6

900 42 22 32 12 27 7 27 7

1050 45 25 33 13 28 8 25 5

1200 48 28 35 15 29 9 25 5

1350 51 31 37 17 29 9 26 6

1500 55 35 38 18 30 10 26 6

1650 58 38 40 20 31 11 27 7

1800 61 41 42 22 32 12 27 7

2100 45 25 33 13 28 8

2400 48 28 35 15 29 9

2700 51 31 37 17 29 9

3000 55 35 38 18 30 10

Table 10.3-1 Safety light curtains, response times
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11.3.2 Multiple light beam safety devices

t_H7 = Response time of the AOPD in ms, MultiScan factor H=7 (FS)
t_PFH7 = Response time of the protective field in ms at H=7 (FS)

Number of beams = 2 Number of beams = 3 Number of beams = 4

Beam
distance
[mm]

t_H7 t_PFH7 t_H7 t_PFH7 t_H7 t_PFH7
500 39 19

400 39 19

300 39 19

Table 10.3-2 Multiple light beam safety devices, response times

11.3.3 Muting transceiver

t_H8 = Response time of the AOPD in ms, MultiScan factor H=8 (FS)
t_PFH8 = Response time of the protective field in ms at H=8 (FS)

Number of beams = 2

Beam
distance
[mm]

t_H8 t_PFH8
600 40 20

500 40 20

Table 10.3-3 Muting transceiver, response times
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12 Appendix

12.1 Scope of delivery

In addition to the scope of delivery, which is defined in the connecting and operating instructions for
the device in accordance with the function package of the receiver and its resolution, the
PROFIsafe receivers are also delivered with:

• A CD-ROM with GSD file, Proxy-FB, example projects and this additional connecting and
operating instructions.

12.2 Accessories ordering information

In addition to the accessories that are defined in the connecting and operating instructions for the
function package of the receiver, the following accessories can also be ordered separately:

Item
number

Item Description

429071 CB-M12-5000S-5GF Cable for power supply with straight M12 socket,
shielded, 5-pole, length: 5 m

429073 CB-M12-10000S-5GF Cable for power supply with straight M12 socket,
shielded, 5-pole, length: 10 m

429075 CB-M12-15000S-5GF Cable for power supply with straight M12 socket,
shielded, 5-pole, length: 15 m

520073 SLAB-SWC SafetyLab parametering and diagnostics software
incl. PC cable, RS232 - IR

520072 CB-PCO-3000 PC cable, RS232 – IR adapter

Table 11.2-1 Accessories ordering information
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12.3 EC Declaration of Conformity

Leuze electronic GmbH + Co. KG
In der Braike 1
73277 Owen – Teck / Germany

The manufacturer declares that the safety components of series COMPACTplus / PROFIsafe
in the form in which they are marketed by us conform with the relevant, basic safety and health
requirements of the EC directives*, and that the standards* were used in their design and
construction.

Owen, 01.02.2009

Dr. Harald Grübel

General Manager

* You can also download this EC Declaration of Conformity from the Internet under:
http://www.leuze.com/compactplus-profisafe


